
SigSimple Walk Though

The following is designed to be a walk though of SigSimple.  This is intended to be a starting
point not the end all be all.  The idea here is to give you enough information and help initially to
get you over the hump and introduce you to the ease of use of SigSimple and sigtags in general.

Ok, lets get started.

Download and install SigSimple.  If you’re lost already go here to find out how to handle this
part.  http://www.ltsw.com/sigsimple/download.htm

Ok now start SigSimple.  The first thing you’ll see is the trial screen.  This screen will tell you
how many days are remaining in your trial period.  The first time you start SigSimple this will be
set to 10 days.  Each day this will go down by 1 until finally you will have 0 days remaining.  At
that point you will either need to stop using SigSimple or purchase the product.  Bare in mind
that the days go down whether you use SigSimple or not.  Each calendar day from the first day to
the 10th day are counted.

When asked for your registration number, it’s that number in the lower left corner of the trial
screen.  If you are still evaluating SigSimple and you have trial days remaining just click the
“Try” button.  The next screen you will see is the setup screen if you haven’t already setup
SigSimple. If you have already setup SigSimple just click on the Tools menu choice and then the
Change Defaults option in the Tools Menu.



Program Parameters

You’ll next see this screen.  On the left hand side you are designating the default folder where
you will store new graphic files.

While we are on this subject let’s try to clear up a very frustrating issue for a lot of users.  A
graphic file and a sigtag are not the same thing.  When you insert a sigtag in a post or email
message what you are actually doing is attaching an html document to your email.  That html
document may in fact point to a graphic but you are nonetheless attaching the html file not the
graphic.  In contrast many users insert a graphic in their email and thing they are using sigtags.
Again this is not the same thing.  By inserting the graphic image, that’s all you’re doing
“inserting a graphic”.  With the html or sigtag option you have the ability to specify text color,
font, font size, tag lines etc. in the document so that when you insert the sigtag you get all the
options that you’ve specified in the html document.

So from this point on when I refer to a graphic file, I’m talking about a graphic file with no
associated html document.  And when I talk about a sigtag I’m talking about an html document
with it’s associated graphic file.



Now back to the subject at hand.  In the boxes on the left you will designate the default folder
that will contain your graphic files (psst.  Not sigtags).  And in the boxes on the right you will
designate your default folder that will contain your sigtags.  These two folders can not be the
same folder.  If you have already set up your program and designated these as being the same
folder, go back now and change one or the other to be a different folder.  Notice that in my
example my default graphic folder (the one on the left) is a sub-folder of the folder on the right.
The reason I’ve set the folder up this way is that I want to store all of my graphics and sigtag
graphics in one folder on my drive so they’re not scattered all over my system.  Also notice that
the folder I’ve selected on the right is really just a parent folder for sub-folders named by
category or occasion.  If you’re not doing this or something very similar, I suggest you change.
Especially if you are using the standard c:\program files\common files\microsoft
shared\stationary folder.  Although this will work I don’t recommend it.  It’s a very long path to
follow and maneuver each time you want to move, rename, or update a sigtag or graphic file.
My recommendation is to create a folder on the root of either your C: drive or your D: drive. Call
it something like Signatures or Siggies or Sigtags or something that makes sense to you and then
create sub-folder under that folder to store your finished sigtags in.  Again I don’t recommend
that you continue to store all of your sigtags in just one folder.  It’s much easier to change the
sigtags you are using at any point in time if you are categorizing them in sub-folder.

And finally in the lower left corner you’ll see a box to enter your sigtag email address.  For the
uninitiated this is an email address that people who read your posts or emails will get when they



click on your sigtag to respond to your post or email.  Did you know that in most cases when you
see one of these sigtags you could just click on the graphic to email the person you posted it.
Some folks don’t like to use their real email address and they will enter things like
spam@nospam.com  This is acceptable from SigSimples point   view.  What you enter here just
needs to be something that looks like an email address so as not to cause an error in your sigtag.
Finally, just click the “Save Information” button to save your changes and go to the SigTag
Maintenance Screen.  If you change your mind about these setting later you can just come back
here and change whatever needs to be changed.

Before we actually get into SigTag Maintenance.  If you start the SigSimple and go directly to
SigTag Maintenance, you will first see this screen.  It’s a popup screen called Tip of the day that
appears each time you start SigSimple.  This will contain a variety of tips that will make your life
with SigSimple even simpler.  These tips will be updated when new issues arise with our users,
we’ll pass on to you the information here.



SigTag Maintenance

You can now see the importance of the folder selection in the previous section.  On the left side
of the screen you’ll notice the source files are pointing to the folder we specified in program
parameters for the “were we save our new graphics”..  And on the right is the folder we specified
for the “default path for our sigtags”.  This is the destination folder we use when we create new
sigtags.  Just below the source and destination folder boxes you’ll notice the boxes with the files
listed.  These are the source and destination file folders.  They’ll contain a list of all available
graphic files in each respective folder.  Just below those boxes are two more boxes that are just
general information.  They generally will contain information about the two different sections,
source files and destination files. In the center of this screen you see a scrollable picture box that
will contain a preview of the graphic you are using.  Below that are the install, refresh, font and
tag line buttons as well as the color selection boxes, use and pick and two check boxes use text
color and include tag lines.  Now that we know where all of the controls are lets talk about them
individually.



If we select a graphic in the source files you’ll see that the graphic is displayed in the preview
box in the center of the screen.  This serves a couple of purposes, the obvious advantage is that
you can see the graphic you’re working with to make creating your sigtag much more straight-
forward.  In addition the displaying of the graphic allows you to pick colors directly from the
graphic for matching text colors to the graphic itself.  If your graphic is larger than the box you
can use the scroll bars on the right and bottom edges of the box to scroll right and left or up and
down to see all of your graphic.

In the source files box itself there a few things you should know.  If you highlight a file that
contains any forbidden characters. ~`!@#$%^&*()_-+={}[]|\:;”’<>,?/ you will be prompted to
rename your graphic before continuing.  In addition to the forced rename, you also have the
ability to rename you graphic by choice.  After highlighting a file name if you right click with
your mouse you will see a menu that will give you several options.  You can rename, move or
delete the highlighted graphic.  These choices should be pretty self-explanatory, however lets
just go over them real quickly so as to avoid any confusion.



• Rename graphic – allows you to give your graphic a new name but will prevent you from
using an existing name

• Move graphic – lets you move the graphic to a different fold.  If you choose this option the
graphic will be moved from the source folder to whatever folder you have selected for your
destination folder.

• Delete graphic - this choice allows you to physically delete the graphic file.  Remember when
you perform this option that the file will be permanently deleted and will not be able to be
recovered, the file does not go to the recycle folder of you operating system.

You’ll also notice that once you have selected a graphic in the source folder the install button
and the “include text color” and “include tag line” check boxes are now available.  At this point
you don’t have to do anything else to install a sigtag.  Be sure to select the folder you want as the
destination for your new tag and click the install button.  That’s really all there is to installing
your new sigtag.  Your graphic file will move to your destination folder and you now have a new
sigtag including the html file to insert into your next post or email.  Or you could insert this new
sigtag into the randomizer and let the randomizer insert your sigtags for you.



If you want to take advantage of the advanced features of SigSimple, read on.  Before clicking
the install button.  You might want to include text color and font settings.

If you check the include text color box you’ll see that the font button is now available and you
can now move your mouse over the image to select a color for your text.  The mouse pointer will
become an eyedropper to select the color.  The “Pick” color box will show the color under the tip
of the eyedropper and the “Use” color box show the selected color. To select a color all you have
to do is find the color you want in the “Pick” box and the left click with your mouse and the
color will appear in the “Use” box.



Now click on the font button. And you will see this screen.  Here you can set your default font
name, your default font size and the text that will appear in your sigtag to hold these settings.
Let me explain what that means.  In order to hold font name, size and color in the sigtag you
have to actually place some text in the html document to do that.  The text that is in the “Enter
Text Here” box below is the text that will appear in the sigtag when you create it.  By default
SigSimple will use a text line of “SigSimple Text” to do this.  If you want to change the default
text you just come here, enter the text you want to use as your default text and click on the “Save
As Your Default Text” button.  If you want to change the default font name or size do the same
thing.  Just change the name or size here and then click the “Save As Your Default Font” button.
This way if you have a favorite font you can set it up and not have to return here every time you
install a sigtag and only come here when you want to use a font other than your default.  I
probably also need to briefly mention the Punctuation section.  Many special fonts do not include
punctuation or their version of punctuation doesn’t resemble what you would expect.  Every time
you select a different font the Punctuation area will be updated with the punctuation from the
font you’ve selected as a visual aid to determine if you want to use that font.

When you’re satisfied with your font selection just click the OK button and your selections will
be used for your next sigtag installation.



Again, you don’t have to go any further just click the install button and off you go.

If you would like to include tag lines in your graphic just check the box “Include tag lines” and
the tag lines button becomes available.



Click on the tag lines button and you will see the following screen.  Just like in the font section
SigSimple comes with default values in these fields.  These options apply to the tag lines only,
the font name, size and color here do not apply to any of the other parts of your sigtag.  If you
want to change the defaults, just make your selections and then click the “Save As Default Tag
Line” button.  From then on anytime you select “Include Tag Lines” these defaults will be
applied to your sigtag.

The Sample text box only shows the first line of your tag lines  and you have up to six lines of
text you can use in tag lines.  You can also use the font and color settings you’ve chosen for the
sigtag you are preparing to install by checking the option above that says “Use this sigtags
settings”  this will set the font name, size and color to the same settings you’ve used earlier for
this sigtag only.

Once you’re satisfied with your selections just click the “Use This Tag Line” button and your
settings will be used for this sigtag.

That’s it, you’re all finished.  Again, be sure to select the folder where you want this sigtag to be
saved in the destination folder and just click the install button.  All of your selected options will
be integrated into the html file and the graphic file will be moved to your destination folder.



Randomizer Maintenance

Now let’s talk about Randomizer Maintenance, this is no doubt one of the biggest reasons most
users love SigSimple.  With this feature you no longer have to select a sigtag each time you
create an new post or email in Outlook Express.  If you set up the Randomizer and set the
Randomizer as your default sigtag a different sigtag will be inserted into each post or email from
from the ones you’ve selected.

Setting up the randomizer is very simple but there are a few things you need to understand. The
list on the right “Randomizer SigTags” is just that, just a list.  These are not your actual sigtags,
if you insert or remove sigtags into or out of this list, you’re not actually effecting the location of
or the existence of your sigtags.  By removing a sigtag from this list, you’re not deleting your
sigtag or even moving it to a different location.  This is just a list of filenames that the
Randomizer uses to determine which sigtags to include in your posts or emails.

On the left is a folder listing you can use to traverse your drives and folder to select the sigtags
you want to include in the Randomizer.



Remember, earlier when I was talking about the importance of setting up sub-folder by
categories or occasions.  This is really where this becomes so important.  If you’ve done this you
can now select entire lists of sigtags to insert into your Randomizer based on those categories or
occasions.  So Christmas has passed and now you want to use New Years tags or Valentines
Days is coming up shortly and you want to use those tags.  If you have them broken down in this
type of manner changing is really simple.

All I would have to do is click the “Remove All” button, that takes all the existing entries out of
the file list.  Then I just click in the folder box on Christmas which gives me my new listing in
the file list below.  Click the “Add All” button and I now have all my Christmas sigtags ready to
be inserted for me.

Anytime you insert or remove listings in the Randomizer you will see a prompt in the lower right
corner telling you to “Save Changes!” just click the “Save Changes” button and the Randomizer
will start using your new listing.

Just below the “Save Changes” button is a drop down box that indicates the Refresh interval.
This is where you change the interval with which the Randomizer changes your sigtag.  Every
5,10,15,20,25 or 30 seconds the Randomizer will change your sigtag to the next one in your list.



You can add and remove in bulk or individual listings by using the Add All, Add, Remove and
Remove all buttons.

That’s it for the Randomizer other than setting it as the default and starting and stopping the
randomizer.  These things you do from the main menu, Tools option.

To Set the Randomizer as the default just click the Tools menu then select Set Radomizer as
Default Signature.  If Outlook Express is open when you do this, you will be prompted to shut
down Outlook Express and restart it.

If the Randomizer is running you will have the option here to “Stop Randomizer” if the
Randomizer is not running you will have the option here to “Start Randomizer”.

Other menu options include “View” and “Help”.



The “View” option give you two choices, SigTag Maintenance and Randomizer Maintenance.
This should be self-explanatory.  If you are on the SigTag Maintenance screen and you want to
see the Randomizer Maintenance Screen just click here and select Randomizer Maintenance.  If
you are on the Randomizer screen and want to seek Sigtags click here and select SigTag
Maintenance.

That’s all on the View Menu



On the Help Menu you can retrieve the “Tip of the Day” view the help file under “Contents” and
get system information about SigSimple in “About SigSimple”.

That’s the Walk Through, with this information you should be able to create new sigtags with all
the options.  With practice it will become old hat.  You’ll never again have to have a bare post or
email.  You can now include all your beautiful sigtags in your post without even thinking about
it.

Enjoy and if you have any problems or questions don’t hesitate to contact Leisure Time Software
at techsupport@ltsw.com .


